
Comparing LibreOffice and Apache OpenOffice
LibreOffice and Apache OpenOffice both are derived from the former OpenOffice.org project. Over the years, the 
differences have grown and these documents offer a list of all the changes. This document is the starting point for 
the information comparing the two office suites.
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 Each ApacheOpenOffice release gets one update
 Each LibreOffice release typically gets 6 or 7 updates
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Simply the office suites are composed of 3 'layers'

1. Feasibility & Smart use: performance, interoperability, look and feel interface.

2. In detail: improvements from word processing up to mathematical formulas. 

3. Localization & Basement: language support, infrastructure, code.
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Comparison overview
There is a huge number of changes and developments. They are presented in separate documents that you can 
open by clicking the following shapes.
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Word – Excel – Visio – Powerpoint – general – 
handi features – ooxml & rtf-filters – improvements

1.2 feasibility / 
interoperability

Basic IDE & scripting
1.3 feasibility / 

scripting

GUI / start center – direct view – sidebar – dialogs – 
fresh look & features – displaying – cleanup – etc.

2 smart use

direct entry – lay-out / style – word & character 
counting – labels – embedding – track changes

3  Writer 

pivottables – sheets & tabs – autofilter – conditional 
formatting – csv – formula / statistics – charts – etc.

 4 Calc

masterpages – controlling – direct view & entry – 
handi features – graphics – miscellaneous

 5 Impress / Draw 

PostgreSQL integration – query dialogs – 
Access2Base

 6 Base 

format dialogs – formulas – symbols 7 Math

new languages – spell & grammar – dates & 
numbers – language tools – miscellaneous

8 localization

API changes – removal / deprecation – 
infrastructure – code quality

9 basement

Core, clean & fixes – infrastructure – Calc 
performance – general performance – accessibility

1.1 feasibility / 
performance



Summary

90% of the improvements are realized in LibreOffice, this software renews or develops quicker and surpasses 
Apache OpenOffice. LibreOffice stands for quality software both in enterprise and private use, with corresponding 
(professional) user support. 

Some highlights

• Modern user interface with many many usability improvements over all modules, faster handling, 100+ 
localizations, improved accessibility.

• Interoperability: numerous improved import and extra file formats such as Visio and Corel, Smart-Art, export to 
OOXML.

• Writer: easier handling of header/footers, improved interoperability with page lay out, stable labels, printing of 
notes and much more.

• Calc: huge speed up especially on larger files, better Excel compatibility in features and functions, Chart and 
DataPilot improvements.

• Base: continues improvements, with also a native PostgrsQL driver.

• Math: continues improvements, with symbols and formatting.

• Impress/draw: including of color palettes, video, and easier and more stable use of master pages.

• Connectivity boost with CMIS integration, Google Drive, Sharepoint, Alfresco and more.

• Development: (relatively) fast and easy building, even on Windows. Neat integration with various IDE's. Modern 
and fast source and patch handling with git and gerrit.
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1.1 Feasibility – performance

1.1-01 core, clean & fixes

1.1 PERFORMANCE  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

core, clean & fixes AOO 4.1 LO 4.4

Integration of session installer to add missing parts 
of LibreOffice on the fly.  [ -.- | 4.0 ] - + ▸

Linux fontconfig leak fixed, saving on use RAM.  
[ -.- | 3.4 ] - +

Removed localized palette files and have them 
localized run-time.  [ -.- | 3.4 ] - +

Remove compatibility support layer old Windows 9x.
[ -.- | 3.4 ] - +

Removed inefficient, and un-necessary 'BmpColor-
Mode' approach to accessibility theming.  [ -.- | 3.4 ] - +

Removed 150 duplicated redundant 'missing icon' 
icons to reduce bloat.  [ -.- | 3.4 ] - + ▸

Legacy binary file format filters cleanup.  [ -.- | 3.5 ] - +
A "stealth mode" to not automatically access a 
document's external references.  [ -.- | 4.2 ] - + ▸

Reduce Java: Port Fax and Letter Wizard to Python.  
[ -.- | 4.0 ] - +

Reduce Java: Port Agenda Wizard from Java to 
Python.  [ -.- | 4.1 ] - +

Reduce Java: Port Web Wizard from Java to Python.  
[ -.- | 4.1 ] - +

Text layout on Mac OS X has been ported from the 
deprecated ATSUI framework to Core Text.  [ -.- | 4.1 ] - +

Under Windows, use keys under HKLM/Policies/Li-
breOffice to make it possible to manage LibreOffice 
configuration with Group Policy Objects in Windows 
domains.  [ -.- | 4.2 ]

- ++

Algorithm of reordering sorted data has been over-
hauled. Sorting of large data set goes faster.  [ -.- | 4.3 ] - +

Removed unnecessary text-attributes-changed 
events when typing.  [ -.- | 4.3 ] - +

Redundant image swap out/in has been significantly 
cleaned up avoiding wasteful image load/save.  
[ -.- | 4.4 ]

- +
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1.1-02 infrastructure

1.1 PERFORMANCE  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

infrastructure AOO 4.1 LO 4.4

https://gerrit.libreoffice.org/ used for code review 
and easy patch submission.  [ -.- | 4.0 ] - + ▸

All legacy container classes (Sv*Array*, Table, Con-
tainer, List etc.) replaced with STL containers. 
[ -.- | 4.0 ]

- +

Translations module became a source-only module, 
l10n tools read translations directly from .po files. 
[ -.- | 4.0 ]

- +

Tinderbox building bibisect repo. [ -.- | 4.0 ] - +
Tinderbox integration. [ -.- | 4.0 ] - +
Initial bibisect proof-of-concept. [ -.- | 4.0 ] - +
Port to gnumake, significant build parallelism and 
build-time improvements. [ -.- | 4.1 ] - ++ ▸

Now using autoconf to produce separate con-
fig_host/config_feature. [ -.- | 4.1 ] - +

New, much cleaner and more readable service 
constructors. [ -.- | 4.1 ] - +

L10ntools refactoring, remove obsolete behaviours, 
deduplicate functions and increase the efficiency of 
merge of translations. [ -.- | 4.1 ]

- +
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1.1-03 Calc performance

1.1 PERFORMANCE  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

Calc performance AOO 4.1 LO 4.4

Massive re-work of external reference handling 
fixing defects in formula calculations involving exter-
nal references, and to boost data caching.  [ -.- | 3.4 ]

- +

Now support 10000 sheets and improved 
performance operations.  [ -.- | 3.5 ] - ++

improvement on import of Excel documents con-
taining a large number of form controls.  [ -.- | 3.5 ] - +

Improved ods load times.  [ -.- | 4.0 ] - + ▸

improvement on the import of cell formats from 
Excel documents.  [ -.- | 3.5 ] - +

Improved ods import with documents with large 
number of named ranges.  [ -.- | 3.5 ] - +

Improved performance pivot tables in Calc.  [ -.- | 3.6 ] - +
Improved import raw cell value from .xlsx.  [ -.- | 3.6 ] - +
Improvement merged cell and matrix range import 
from .ods files. [ -.- | 3.6 ] - +

Significant speed up on export of ods document that
contains a large number of rich-text cells.  [ -.- | 4.2 ] - + ▸

Improved xlsx load time.  [ -.- | 4.0 ] - +

Calc's cell storage structure has been completely re-
written. Improved locality of reference as well as the 
cost of storage.  [ -.- | 4.2 ] 

- +

Added an experimental feature of live data 
streaming, it is disabled by default.  [ -.- | 4.2 ] - + ▸

Sharing string instances stored in cells to speed up 
sensitive and insensitive string comparisons, and to 
allow string equality check in OpenCL-based. [ -.- | 4.2 ]

- +

Vertically adjacent formula cells share their formula 
token array instance.  [ -.- | 4.2 ] - +

xlsx import filter has been re-worked on the import 
performance on xlsx documents.  [ -.- | 4.2 ] - +

Experimental import for xlsx documents. Calc 
import xlsx documents using multiple threads for 
multiple sheets import concurrently.  [ -.- | 4.2 ] 

- +

Cell note storage uses multi_type_vector.  [ -.- | 4.2 ] - +
Improved VLOOKUP function with use of external 
references.  [ -.- | 4.2 ] - +

Improved SUM, COUNT, SUMIFS function.  [ -.- | 4.2 ] - +
New formula interpreter for parallel calculations of 
formula cells using GPU via OpenCL. [ -.- | 4.2 ] - +
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1.1-04 general performance

1.1 PERFORMANCE  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

general performance AOO 4.1 LO 4.4

Shrink Windows installer download by using better 
compression schemes. [ -.- | 3.4 ] - +

Startup on Linux: with splash screen before starting 
to read all the application's data. [ -.- | 3.4 ] - +

Seldom used text encoding conversions in a separa-
te library, saving RAM. [ -.- | 3.4 ] - +

Accelerated multimedia previews on Linux. [ -.- | 4.0 ] - + ▸

Graphite smart font rendering support is rewritten. 
[ -.- | 3.4 ] - +

Flat ODF import/export filters from Java to C++ 
giving a huge speed increase. [ -.- | 3.4 ] - +

Large document scrolling/re-layout/interactive edi-
ting improvements. [ -.- | 3.6 ] - +

Improved saving a new entry to a large autocorrect 
replacement table. And handling speed up. [ -.- | 4.0 ] - +

Load and save time improvements slides / drawings 
with large numbers of shapes. [ -.- | 4.0 ] - + ▸

Significantly improved RTF file load times.   [ -.- | 4.0 ] - +
Increased size limit on (uncompressed) ODF docu-
ments from 2Gb to 4Gb. [ -.- | 4.0 ] - +

Use a hash for auto-correction until it needs to be 
sorted.  [ -.- | 4.1 ]  - +

Don't parse fourteen thousand lines of label 
descriptions on every startup, defer them until a 
sheet of labels is used. [ -.- | 4.1 ]

- +
 

Refactored large parts of Writer code, split the large 
classes into smaller interfaces. [ -.- | 4.4 ] - +

FastSerializer classes used by all OpenXML export. 
[ -.- | 4.4 ] - +

Loading large autocorrect are parsed in a thread by 
the fastparser. Repeated parsing of unchanged files 
is avoided. [ -.- | 4.4 ]

- +

Thumbnails are now compressed to PNG-8. [ -.- | 4.4 ] - +
JPEG-Turbo library for loading and de-compressing. 
[ -.- | 4.4 ] - + ▸

Mail merge Writer processing faster with a large 
number of records. [ -.- | 4.4 ] - +
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1.1-05 accessibility & miscellaneous

1.1 PERFORMANCE  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

accessibility & miscellaneous AOO 4.1 LO 4.4

Impress remote control for Android phones. [ -.- | 4.0 ] - ++ ▸

Impress remote control for iOS.  [ -.- | 4.2 ] - ++
Embedded HSQLDB databases are size-minimized 
before saving with "CHECKPOINT DEFRAG".  [ -.- | 3.6 ] - +

Presenter Console RTL support.  [ -.- | 4.0 ] - +
A single MSI file for installing, with everything 
embedded.  [ -.- | 3.5 ] - +

Different Encryption Algorithm (AES). Files with the 
old encryption of course can be used.  [ 3.4 | 3.5 ] + +

Support for Japanese postcard paper size.  [ -.- | 3.6 ] - +
Port from Java to IAccessible2 for high fidelity Win-
dows accessibility.  [ 4.1 | 4.3 ]  + +

Autodetecting fax4CUPS machines and prompt for 
the fax number. Multiple numbers can be entered.  
[ -.- | 4.3 ] 

- +

Expose role change between heading and paragraph
through a new UNO accessibility event.  [ -.- | 4.3 ] - +

Notify misspelled words to accessibility.  [ -.- | 4.3 ] - +
Use quick help text as the accessible name for 
toolbar buttons if not explicitly set.  [ -.- | 4.3 ] - +

Much accelerated docx hyperlink import.  [ -.- | 4.3 ] - +
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1.2 Feasibility – interoperability

1.2-01 Writer & Word

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

Writer & Word AOO 4.1 LO 4.4

Allow different header and footer on the first page 
without using a separate page style.  [ -.- | 4.0 ] - ++ ▸

Importing doc, docx, and rtf files, the numberings 
are not split on new lines if they do not fit.  [ -.- | 3.5 ] - +

Layout fixes tab stop at the end of margins. When 
importing doc, docx and rtf files, the numberings 
aren't split on new lines if they don't fit.  [ -.- | 3.5 ] 

- +

Support for comments export/import in OOXML 
(docx) documents.  [ -.- | 3.5 ] - +

Writer rtf import rewrite.  [ -.- | 3.5 ] - +
VML import handles lines, rotations, flips.  [ -.- | 3.6 ]  - +
Support for contextual spacing.  [ -.- | 3.6 ] - + ▸

Numerous significant improvements to interopera-
bility with Microsoft Word's docx format. OOXML 
filter improvements.  [ -.- | 4.2 ] 

- +

Windows: updated build environment (Windows Ser-
ver 2012R2 + Visual Studio 2012). rtf/docx import/ex-
port handles document zoom settings.  [ -.- | 3.6 ] 

- +

Docx import now handles GetExpression and 
SetExpression fields.  [ -.- | 3.6 ] - +

Support for importing Office SmartArt.  [ -.- | 3.6 ] - +
Embedding fonts in a Writer document.  [ -.- | 4.1 ] - ++ ▸

Improved simple .doc/.docx import.  [ -.- | 3.6 ] - +
Docx improvements: import of floating tables, OLE 
objects inside rectangles, margins of inline images 
using the WordProcessing markup.  [ -.- | 4.0 ] 

- +

The docx import filter now handles non-bitmap 
drawingml shapes.  [ -.- | 4.1 ] - +

Fix for page border margins in docx.  [ -.- | 4.2 ] - +
Import ink annotations in docx and rtf documents.  
[ -.- | 4.0 ] - + ▸

Fix different Odd & Even page flag ignored.  [ -.- | 4.2 ] - +
Fix for hidden footer being imported to Writer as 
normal footer.  [ -.- | 4.2 ] - +

Writer now preserves underline color.  [ -.- | 4.2 ] - +
Writer now preserves character shading.  [ -.- | 4.2 ] - +
Preserving page numbers that don't start at '1'.  
[ -.- | 4.2 ] - +

Borders in headers\footer not being lost anymore.  
[ -.- | 4.2 ] - +
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Writer can now create dot files.  [ -.- | 4.2 ]  - +
Writer preserves the 'Track Changes ON' when pre-
sent in a docx (track changes data itself is partially 
preserved).  [ -.- | 4.2 ] 

- +

Import/export of graphical bullets of numberings in 
the doc, docx and rtf filters.  [ 4.0 | 4.1 ] + + ▸

Solid page background color roundtripped in docx.  
[ -.- | 4.2 ]  - +

Fix export of text-box inset property to docx. [ -.- | 4.2 ] - +
Fix for docx export of page border.  [ -.- | 4.2 ]  - +
Fix for preservation of bullets with level 0.  [ -.- | 4.2 ]  - +
Fix for page border shadows in docx.  [ -.- | 4.2 ]  - +
Text-Box background gradient color now preserved 
correctly.  [ -.- | 4.2 ] - +

Preserve rotation information on bitmaps.  [ -.- | 4.2 ] - +
Fix position and size values on exported shapes.  
[ -.- | 4.2 ]  - +

Preserve Smart-Art information.  [ -.- | 4.2 ] - +
Fix alignment/directionality when open docx file.  
[ -.- | 4.2 ] - +

Fix wrong directionality after save file created by MS.
[ -.- | 4.2 ]  - +

OOXML floating table improvements.  [ -.- | 4.2 ]  - +
Ampersand in document title by docx.  [ -.- | 4.2 ]  - +
Preserve style attribute on shapes and tables.  
[ -.- | 4.3 ] - +

Save embedded spreadsheets, presentations, etc. in 
docx documents. [ -.- | 4.3 ] - +

docx import handles explicit horizontal merges of 
table cells. [ -.- | 4.3 ] - +

docx import floating tables anchored inside tables. 
[ -.- | 4.3 ] - +

Brand new drawingML-based docx import/export 
filter for shapes and TextFrames. [ -.- | 4.3 ] - +
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1.2-02 Calc & Excel

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

Calc & Excel AOO 4.1 LO 4.4

Preserve OLE links to other Excel documents when 
importing an Excel document. [ -.- | 3.4 ] - ++

DBF Import/Export dialog preferences are saved. 
[ -.- | 3.5 ] - +

Import/export color scales and data bars with xlsx.. 
[ -.- | 4.0 ]  - + ▸

Direct view on values of formula in ods and xlsx files 
as saved in the files (cached), without recalculating 
the formula directly when opening the file. [ -.- | 4.0 ]  

- ++

Import/export functions new in Excel 2013 for ODF 
OpenFormula compatibility. [ -.- | 4.1 ]  - +

COVARIANCE.P and COVARIANCE.S spreadsheet 
functions for MS-Excel interoperability. [ -.- | 4.2 ]  - +

STDEV.P , STDEV.S spreadsheet functions. [ -.- | 4.2 ]  - +
VAR.P and VAR.S spreadsheet functions. [ -.- | 4.2 ]  - +
BETA.DIST , BETA.INV spreadsheet functions. [ -.- | 4.2 ] - +
BINOM.DIST and BINOM.INV functions.  [ -.- | 4.2 ]  - +
CONFIDENCE.NORM and CONFIDENCE.T spread-
sheet functions.  [ -.- | 4.2 ]  - +

F.DIST, F.DIST.RT, F.INV, F.INV.RT and F.TEST spread-
sheet functions.  [ -.- | 4.2 ] - + ▸

EXPON.DIST, HYPGEOM.DIST, POISSON.DIST and 
WEIBULL.DIST spreadsheet functions.  [ -.- | 4.2 ]  - +

Import charts from xlsx which don't have proper 
references but have internal data.  [ -.- | 4.2 ]  - +

GAMMA.DIST, GAMMA.INV, GAMMALN.PRECISE. 
[ -.- | 4.3 ]  - +

LOGNORM.DIST, LOGNORM.INV, NORM.DIST, 
NORM.INV, NORM.S.DIST and NORM.S.INV.  [ -.- | 4.3 ]  - +

T.DIST, T.DIST.2T, T.DIST.RT, T.INV, T.INV.2T and 
T.TEST spreadsheet functions.  [ -.- | 4.3 ]  - +

PERCENTILE.EXC, PERCENTILE.INC, PERCENT-
RANK.EXC, PERCENTRANK.INC, QUARTILE.EXC, 
QUARTILE.INC, RANK.EQ and RANK.AVG.  [ -.- | 4.3 ]  

- +

MODE.SNGL, MODE.MULT, NEGBINOM.DIST and 
Z.TEST spreadsheet functions.  [ -.- | 4.3 ]  - +

FLOOR.PRECISE, CEILING.PRECISE and ISO.CEILING. 
[ -.- | 4.3 ]  - +

NETWORKDAYS.INTL and WORKDAY.INTL spread-
sheet functions.  [ -.- | 4.3 ]   - +

ERF.PRECISE and ERFC.PRECISE spreadsheet 
functions.  [ -.- | 4.3 ] - +

AGGREGATE spreadsheet function. [ -.- | 4.4 ]  - +
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1.2-03 import from Visio

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

import from Visio AOO 4.1 LO 4.4

Extended coverage of Visio file-format. Supporting 
of all existing Visio file formats from 1.0 released in 
1992 to Visio 2013.  [ -.- | 4.0 ]  

- ++
▸

Import filter for MS Visio documents.  [ -.- | 3.5 ] - +
Metadata is imported from vsdx.  [ -.- | 4.4 ]  - +
Metadata is imported from vsd.  [ -.- | 4.4 ] - +

1.2-04 Impress & Powerpoint

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

Impress & Powerpoint AOO 4.1 LO 4.4

Better support for importing Smart Art, reducing 
broken imports from pptx with smart arts.  [ -.- | 3.5 ] - ++ ▸

Improved Custom Shapes and their Presets pptx 
import, new presets implementation are added.  
[ -.- | 3.5 ] 

- +

Better handling of export to pdf for hidden slides.  
Per default, hidden slides are excluded, but they can
be included per check-box.  [ -.- | 3.5 ] 

- +
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1.2-05 general interoperability

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

general interoperability AOO 4.1 LO 4.4

It is possible to connect to OneDrive directly from 
LibreOffice.  [ -.- | 4.4 ]   - ++ ▸

It is possible to connect to SharePoint 2009/2013 
directly from LibreOffice.  [ -.- | 4.4 ]   - ++

Separate borders width and style for Writer, Calc 
and Impress.  [ -.- | 3.4 ] - +

New 3D border types to increase compatibility with 
loads of file formats, including ODF.  [ -.- | 3.4 ]  - +

Re-work legacy StarOffice (pre 2000) binary file 
format filters, this also removes clutter from the 
'Save As' dialog.  [ -.- | 3.4 ]   

- +

Support embedding Palettes and other property list 
types. Added the ability to (selectively) embed these 
inside the ODF container.  [ -.- | 3.5 ]  

- ++
▸

Support for export and import of Math formulas in 
Office Open XML (docx) documents.  [ -.- | 3.5 ]  - +

Metric compatible fonts, key to improved interoper-
ability. (See: 3-03 Writer lay-out for all LibreOffice 
details since 3.5.)   [ 3.4 | 3.5 ]  

+ ++

Line chart's smoothing has been upgraded to the 
ODF 1.2 standard.  [ 4.0 | 3.5 ]   + +

Support Color and line styles for the columns and 
footnote separator lines. Better compatibility of 
LibreOffice with ODF.  [ -.- | 3.4 ]  

- +
▸ 

Import filter for Corel Draw documents.  [ -.- | 3.6 ]  - +
Improved OLE2 document import: .doc, .xls and .ppt.
[ -.- | 3.6 ]   - +

ODF Export comes with a "ODF 1.2 Extended (com-
pact mode)" giving better interoperability with older 
consumers Open document Format.  [ -.- | 3.6 ]  

- +

CMIS protocol support for easy access to document 
stored on document Management Systems like 
Alfresco, Nuxeo, SharePoint...   [ -.- | 4.0 ]  

- ++

On all non-Windows platforms a new mork driver 
implementation is used to access Thunderbird 
address book.  [ -.- | 4.0 ]  

- +

Import filter for Microsoft Publisher publications.  
[ -.- | 4.0 ] - + ▸

Improved ODF compatibility in various points. 
[ -.- | 4.0 ]   - +

Initial work on a gnumeric import filter based on 
orcus.  [ -.- | 4.0 ]  - +

Direct access media file types (wma), (wmv),  (aac), 
(flv),  (ogx), rmi midi Audio and (SouND).   [ -.- | 4.1 ]    - ++

Numerous improvements to the Microsoft OOXML 
Import and Export filters as well as for the Microsoft 
Office binary file formats and  RTFformat.   [ -.- | 4.1 ]  

- +
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Import HTML files with over 64k table cells.  [ -.- | 4.1 ] - +
Libmwaw brings support for a multitude of pre-OSX 
Mac word-processing documents in different file-
formats: Microsoft Word for Mac 5.1, Write Now 4.0, 
MacWrite Pro 1.5, AppleWorks 6.0.  [ -.- | 4.1 ]  

- +
▸

Support document Management Systems: connec-
tion to GDrive is now possible, a CMIS Properties 
dialog allow to edit them.  [ -.- | 4.2 ]  

- +

Import filters e-book formats, FictionBook 2, Palm-
doc, PeanutPress (eReader), Plucker, Tealdoc, zTXT  
[ -.- | 4.2 ]   

- +

AbiWord import filter.  [ -.- | 4.2 ]  - +
Support for MS Office 2009 and 2013 Agile decryp-
tion mechanism.  [ -.- | 4.2 ]  - +

Import of more legacy Mac document types. Acta 
Mac Classic, Beagle Works / WordPerfect Works, 
Great Works, Macdoc, More Mac v2-3.  [ -.- | 4.2 ]  

- +

Apple Keynote import filter.  [ -.- | 4.2 ]  - +
A host of legacy Mac formats. BeagleWorks, Claris-
Works, Claris Resolve, GreatWorks, MacWorks, 
Wingz spreadsheets. And GreatWorks, MacPaint, 
MacWorks, SuperPaint.  [ -.- | 4.3 ]  

- +

Draw can import Adobe PageMaker files.  [ -.- | 4.3 ]  - ++
Easy access media file: Real Audio (.ra), Real Media 
(.rm), Digital Video (.dv), Audio Codec (.ac3), Ogg 
Opus (.opus), Advanced Systems (.asf), MPEG (.m4a).
[ -.- | 4.4 ]   

- +

Ability to import files from MacDraw, MacDraw II 
and RagTime for Mac (v. 2-3) in Draw and Writer.  
[ -.- | 4.4 ]  

- +

MS Publisher: Embedded fonts are now imported.  
[ -.- | 4.4 ]  - +

MS Publisher: Tables are now imported.  [ -.- | 4.4 ]   - + ▸

MS Publisher: Metadata is now imported.  [ -.- | 4.4 ]   - +
Abiword: Text language is now correctly set.  [ -.- | 4.4 ] - +
Abiword: Globally defined writing mode is used.  
[ -.- | 4.4 ]   - +

Abiword: Headings are now recognized.  [ -.- | 4.4 ]  - +
Abiword: Metadata is now imported.  [ -.- | 4.4 ]  - +
MS Works Spreadsheet: An old Lotus LICS character 
encoding is now recognized and converted.  [ -.- | 4.4 ] - +

FictionBook: Text language is now set.  [ -.- | 4.4 ]  - +
FictionBook: Headings are now imported.  [ -.- | 4.4 ]  - +
Writer can now import Sony BroadBand eBook (lrf) 
files, via libe-book.  [ -.- | 4.4 ] - +
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1.2-06 handi

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

handi AOO 4.1 LO 4.4

SVG export now also includes hyperlinks.  [ -.- | 4.1 ]   - +
Theme fonts support: detect and render the proper 
fonts and preserve font theme attributes.  [ -.- | 4.3 ]   - + ▸

It is possible to export CSS2 dot leaders by enabling 
Print layout. Via save the HTML Document file type 
in the Save As dialog of Writer.  [ -.- | 4.4 ]  

- +

1.2-07 OOXML and RTF-filters

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

OOXML and RTF-filters AOO 4.1 LO 4.4

RTF filter now imports old Drawing Objects syntax.  
[ -.- | 4.0 ]   - + ▸

Use copy-on-write for RTF import stack - significantly
accelerates large RTF document import.  [ -.- | 4.1 ]   - +

RTF import: added initial support for group shapes.  
[ -.- | 4.2 ]    - ++

Support for OOXML encryption.  [ -.- | 4.2 ]   - +
Numerous improvements to Import/Export filters 
and the MS Office binary file formats.  [ 4.1 | 4.1 ]    + +

Lots of OOXML Filters, docx, xlsx, pptx, vml.  [ 4.1 | 4.1 ] + +
Other improvements on the Microsoft OOXML 
Import and Export filters, etc..  [ 4.1 | 4.2 ]     + + ▸

Significant speedups of all OOXML parsing - by 
splitting parsing / tokenisation into a separate 
thread, and many other optimisations to FastParser.
[ -.- | 4.2 ]    

- +

Initial import support for OOXML Strict in the docx, 
xlsx and pptx formats.  [ -.- | 4.3 ]   - +

Importing OOXML documents with lots of relations 
is much faster.  [ -.- | 4.3 ]    - +

Metadata is now imported from pptx.  [ -.- | 4.4 ]   - +
Custom wrap polygon is exported to docx.  [ -.- | 4.4 ]   - +
Support for bitmaps when exporting cropped 
images to docx.  [ -.- | 4.4 ]    - +
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1.2-08 improvements

1.2 INTEROPERABILITY  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

improvements AOO 4.1 LO 4.4

Tab stop and end margin behavior fixed.  [ -.- | 3.5 ] - +
DF bookmarks don't contain footnote numbers.  
[ -.- | 4.2 ] - + ▸ 

SVG export: fix double stroke-width problem. 
[ -.- | 4.2 ] - +

SVG export: support stroke-linecap and stroke-
linejoin.  [ -.- | 4.2 ] - +

Preserve line and fill theme colors on shapes, 
including color transformations.  [ -.- | 4.1 ] - + ▸ 

Preserve theme colors on fonts, paragraphs and 
table cells.  [ -.- | 4.3 ] - +

Standard Document Tags support: fix export of date 
and checkbox controls, fix import of combobox 
controls.  [ -.- | 4.3 ]

- +

Preserve effects on shapes and pictures, including 
3D effects and artistic effects.  [ -.- | 4.3 ] - + ▸

Gradient shape fill, the render is not accurate but  
the gradient information is completely preserved.  
[ -.- | 4.3 ]

- +

Shape adjustment names are exported according to 
the specification.  [ -.- | 4.3 ] - +

VML import handles optional command parameters.
[ -.- | 4.3 ] - +

Improved drawingML export of pattern fill shapes.  
[ -.- | 4.3 ] - +

Import Line Join and Cap.  [ -.- | 4.3 ] - +
Improve display and editing of rotated text.  [ -.- | 4.3 ] - +
Correctly detect whitespace.  [ -.- | 4.3 ] - +
Improved handling of Writer track changes in group-
shape text.  [ -.- | 4.3 ] - + ▸

Correctly detect colors.  [ -.- | 4.3 ] - +
Correctly position rotated text.  [ -.- | 4.3 ] - +
Fix problem with lines getting stacked.  [ -.- | 4.3 ] - +
Add dashes support.  [ -.- | 4.3 ] - +
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1.3 Feasibility – scripting

1.3 scripting

1.3 SCRIPTING  (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

scripting AOO 4.1 LO 4.4

Docked resizable Object Catalog pane, following 
selection in editing window.  [ -.- | 3.6 ] - ++ ▸

Docked resizable properties window.  [ -.- | 3.6 ] - +
New menu item View -> Line Numbers that toggles 
line numbers in the editor window.  [ -.- | 3.5 ] - +

New menu item View -> Goto Line.  [ -.- | 3.5 ] - +
Dialog controls got a spinbutton.  [ -.- | 3.5 ] - +
Possibility to export basic libraries from Excel 
documents.  [ -.- | 4.4 ] - +

Improved error messages when Python UNO bridge 
fails to load.  [ -.- | 3.5 ] - +

Python UNO can initialize the members of an UNO 
structure by name instead of by position.  [ -.- | 3.5 ] - + ▸

Debugging of user code (rule conditions and Python 
user functions.  [ -.- | 3.5 ] - +

LibreOffice now bundles Access2Base, a simplified 
API for scripting of Base (and Writer database forms)
in Basic. It is concise and easy to learn.  [ -.- | 4.2 ]  

- +
▸

Incompatible change: a checkbox bound to a 
(var)char (string) field will now write 'true' or 'false', 
instead of '1' or '0' (backwards compatible).  [ -.- | 4.2 ] 

- +

Reference values in checkboxes are honoured.  
[ -.- | 4.2 ] - +

Changed the value returned from GetSolarVersion.  
[ -.- | 4.4 ] - +

ProcessEventsToIdle() method to the 
com.sun.star.awt.Toolkit service - calling this causes 
all pending rendering to be completed.  [ -.- | 4.4 ] 

- +

Access2Base update: Methods which can meaning-
fully be used without a database connection are exe-
cutable before any OpenConnection call.  [ -.- | 4.4 ]

- +

Access2Base update: A CloseConnection method 
has been added to free resources.  [ -.- | 4.4 ] - +

Access2Base update: TempVars collection of 
TempVar objects.  [ -.- | 4.4 ] - +

Access2Base update: New properties for (sub)forms:
OrderBy and OrderByOn.  [ -.- | 4.4 ] - +

Access2Base: The ApplyFilter and SetOrderBy 
actions now applicable on table or query datasheets,
and on forms or subforms as well.  [ -.- | 4.4 ]

- +

Access2Base: The GoTorecord method is extended.  
[ -.- | 4.4 ] - +
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2. Smart use

2-01 GUI & start center

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

GUI & start center AOO 4.1 LO 4.4

The start screen allows the user to glimpse recently-
opened documents. You can drop files on it to open 
them.  [ -.- | 4.2 ]

- ++

Preview of all file types in start center, not only ODF. 
Selectively delete Recent Documents.  [ -.- | 4.3 ] - ++

Templates now appear directly in the Start Center 
and can be picked from there.  [ -.- | 4.4 ] - ++ ▸

Recent Documents list is updated on Save, Save As 
and Close.  [ -.- | 3.6 ] - +

Border around the Start Center removed.  [ -.- | 4.3 ] - +
New templates included in the default installation.  
[ -.- | 4.4 ] - +
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2-02 direct view & entry

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

direct view & entry AOO 4.1 LO 4.4

"Apply Style" combobox in the toolbar now features 
previews of the styles to choose.  [ -.- | 4.0 ] - ++ ▸

Print dialog: page input field shows current page by 
default.  [ -.- | 3.5 ] - +

Recent documents list support in the taskbar icon 
on Windows 7 and higher.  [ -.- | 4.2 ] - +

More supported document types have been added 
to the "Open With" menu on Windows.  [ -.- | 4.2 ] - +

Access Recent Documents directly from toolbar.  
[ -.- | 4.1 ] - +

Hide/Show styles in the “Styles & Formatting” dialog. 
[ -.- | 4.0 ] - +

New templates manager to bring the templates to 
the user.  [ -.- | 4.0 ] - + ▸ 

Infobar visibly when a document is being opened in 
read-only mode.  [ -.- | 4.2 ] - +

A language combo box for character attribution with
a field to specify a valid BCP 47 language tag.  
[ -.- | 4.3 ] 

- +

“Bullets” and “Numbering” toolbar buttons got a 
drop-down menu.  [ -.- | 4.4 ] - +

Paragraph line spacing dropdown in the main 
toolbar.  [ -.- | 4.4 ] - +

Support MATE and XFCE Desktops.  [ -.- | 4.2 ] - +
GNOME3 Application Menu integration.  [ -.- | 4.2 ] - +
Cleaner layout for the Start screen, also useful for 
netbooks.  [ -.- | 4.2 ] - +
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2-03 sidebar

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

sidebar AOO 4.1 LO 4.4

Sidebar (Apache OpenOffice/IBM Symphony) with 
resizeable layout (LibreOffice team).  [ 4.0 | 4.1 ] + ++ ▸

Right-to-left\Left-to-right buttons on the Sidebar.  
[ -.- | 4.2 ] - +

Combining functionalities of the old “Gallery” and 
“Styles & Formatting” floating panels, gradually re-
moving a lot of UI redundancy.  [ -.- | 4.4 ] 

- +

Tabs icons as a toggle to open/close sidebar decks.  
[ -.- | 4.4 ] - +

Sidebar open by default in Writer, Calc and Draw 
showing just the tab icons.  [ 4.0 | 4.4 ] + +

Style tabs have new icons.  [ -.- | 4.4 ] - +
The sidebar drop down menu now has a 'Close 
Sidebar' entry.  [ -.- | 4.4 ] - +
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2-04 GUI / contextmenu

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

GUI / contextmenu AOO 4.1 LO 4.4

Initial support for Unity and global menu support.  
[ -.- | 3.4 ] - +

Moved context-sensitive toolbars to the bottom to 
prevent them from overlaying important parts of the
document.  [ -.- | 3.5 ] 

- +

The command "Protect Sheet" is now also accessible
from the context menu of the sheet tab.  [ -.- | 3.5 ] - +

Added support for field items in cells (in editing 
mode).   [ -.- | 3.6 ] - + ▸

Calc now supports allowing pasting only text, value, 
or formula from the context menu.  [ -.- | 3.6 ] - ++

Sheets can now be hidden and/or shown by using 
the sheets tab context menu.  [ -.- | 3.6 ] - +

Merge cells option added to right-click menu.
[ -.- | 3.6 ] - +

Unity integration [only in Linux Distribution builds].  
[ -.- | 4.0 ] - + ▸

The full options of the  ">>" overflow button can be 
shown by right-clicking the toolbar.  [ -.- | 3.6 ] - +

Support Trinity Desktop Environment integration.  
[ -.- | 3.6 ] - +

Writer gives access the Paste Special dialog via the 
context menu.   [ -.- | 4.4 ] - +

Cut, Copy and Paste actions now at the top of the 
context menu.  [ -.- | 4.4 ] - +
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2-05 dialogs

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

dialogs AOO 4.1 LO 4.4

Improve gtk+ theme integration, LibreOffice looks 
more native. Fix menu separators, Alt key issues, 
Toggle buttons, widget rendering details.  [ -.- | 3.4 ] 

- +

Windows are now grouped together by application 
in the taskbar on Windows 7 and higher.  [ -.- | 4.2 ] - + ▸

GTK+ right-to-left interface glitches are more RTL-
aware and consistent with native GTK+ applications. 
[ -.- | 3.5 ] 

- +

GTK themes can render the background gradient.  
[ -.- | 3.6 ] - +

GTK themes have a way for tab prelight rendering.  
[ -.- | 3.6 ] - +

GTK theming for fixed lines and frames.  [ -.- | 3.6 ] - +
introduction of an infrastructure to build user inter-
face dialogs and windows with the XML-based .ui 
format of GtkBuilder/Glade. All dialogs and tabs 
(.src-based) are converted.  [ -.- | 4.4 ] 

- +
▸

Click behaviour status bar was unified: left-click re-
sults in action or dialog, right-click in a context 
menu.  [ -.- | 4.4 ] 

- +
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2-06 fresh look

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

fresh look AOO 4.1 LO 4.4

New object handles that use alpha transparency to 
improve usability. "Large" handles were removed at 
the same time.  [ 4.0 | 3.5 ] 

+ +
▸

Rulers are now much cleaner and more light-weight.
[ -.- | 3.6 ] - +

Redesigned "About" dialog for a cleaner look. 
[ -.- | 3.6 ] - +

Ruler enhancements: show ticks above numbers.  
[ -.- | 4.2 ] - +

More Well-Sized Dialogs.  [ -.- | 4.1 ] - ++ ▸

Multirow tab dialog tab balancing, avoiding single 
orphan tabs.  [ -.- | 4.2 ] - +

New icon set Sifr, designed for non-distracting icons 
to help concentrate on the document.  [ -.- | 4.2 ] - +

Default Sifr icon theme on OS X.  [ -.- | 4.4 ] - + ▸

Background color is tweaked and unified with that of
the rulers, streamlining the default look.  [ -.- | 4.3 ] - +

Update of the Tango icon set and new icons Sidebar.
[ -.- | 4.3 ] - +

improved icons for Tango, Sifr, and Oxygen themes. 
[ -.- | 4.4 ] - +

The Navigation buttons moved from below the 
scrollbar to the Find bar.  [ -.- | 4.3 ] - + ▸

The tabs have an updated look.  [ -.- | 4.4 ] - +
Rulers got smaller numbers, and hidden by default.  
[ -.- | 4.4 ] - +

New browser for Firefox themes including search 
and preview.  [ -.- | 4.4 ] - +
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2-07 handi

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

handi AOO 4.1 LO 4.4

Find bar behaves more like in Firefox or Evolution. Is
hidden by default, is wider as to fit text for Search 
and Replace dialog.  [ -.- | 3.4 ] 

- ++

Added Scan button to the scan dialog unix.  [ -.- | 3.5 ] - +
Select and copy text from message boxes.  [ -.- | 4.0 ] - + ▸

Visual appearance of the Autofilter popup window 
and the ability to allow multiple selections.  [ -.- | 3.5 ] - +

Extension Manager dialog got 3 checkboxes to allow 
the selection of the type of extension: Bundled (In-
stallation), Shared and User, or a combination.  
[ -.- | 3.5 ] 

- +

Improved dialog when saving in other formats than 
ODF.  [ -.- | 3.5 ] - +

Lanczos algorithm for resizing of images.  [ -.- | 3.6 ] - +
Allow for editing of read-only documents.  [ -.- | 3.6 ] - +
Graphics can be resized and recompressed with the 
Compress Graphics popup menu function.  [ -.- | 4.0 ] - + ▸

Add File in Recent Documents menu. Added a Clear 
List feature.  [ -.- | 4.1 ] - +

Delete multiple styles at once from Styles and 
Formatting dialog.  [ -.- | 4.1 ] - +

Add a “Close Search” button to search bar.  [ -.- | 4.1 ] - +
“Match Case” option added to the find bar.  [ -.- | 4.1 ] - +
Make Find hotkey Ctrl+F a toggle command for the 
Find bar.  [ -.- | 4.1 ] - +

Better Quick search with Find bar (Ctrl+F), no influ-
ences of invisible options from the search-and-repla-
ce dialog.  [ -.- | 4.2 ]

- ++

Default proportionally image scaling in Calc and Im-
press/Draw (as they were already in Writer).  [ -.- | 4.4 ] - +

"Find All" added to the Find bar.  [ -.- | 4.2 ] - + ▸

Turn Rulers on or off by key Ctrl+  Shift+R.  ⇧ [ -.- | 4.4 ] - +
Special characters can be inserted/removed at the 
location of the cursor in the field.  [ -.- | 4.4 ] - +

Simply input of special symbols by default. Autocor-
rection: Trademark, copyright, reg. Symbol.  [ -.- | 4.4 ] - +
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2-08 color choice

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

color choice AOO 4.1 LO 4.4

The color picker is rewritten to be more usable.  
[ 3.4 | 3.5 ] + +

Color previews for ‘Automatic’ colors in the combo 
drop-downs.  [ -.- | 3.5 ] - +

Writer and Calc use split color buttons making it 
possible to apply the last used color with one click.  
[ -.- | 3.6 ]

- +

Line color picker changed from list to a color palette.
[ -.- | 4.3 ] - + ▸

In the Math Formula editor you may add colors di-
rectly from the Elements Dock by clicking.  [ -.- | 4.2 ]  - +

Color pickers improved for: Font color (Impress, 
Draw), Font color of drawing objects (Writer, Calc), 
Line color, 3D Extrusion color.  [ -.- | 4.3 ] 

- +

New Color Selector with recently used document 
colors.  [ -.- | 4.4 ] - +

Support for different color palettes and for .gpl 
GIMP palette format.  [ -.- | 4.4 ] - ++ ▸

Color Selector allows to directly open the color 
picker and choose another color.  [ -.- | 4.4 ]  - +
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2-09 displaying

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

displaying AOO 4.1 LO 4.4

Linux text-rendering improvements by drawning via 
Cairo with the common subpixeling options.   
[ -.- | 3.4 ]

- +
▸

Combining diacritics for scientific typesetting and 
localization.  [ -.- | 3.5 ] - +

New Widget layout technique for dialog windows.  
[ -.- | 4.0 ] - ++

Zooming based on a geometric progression.  [ -.- | 3.6 ] - +
Improve quality of displaying images in documents.  
[ -.- | 4.0 ] - +

Improve display Recent Documents list.  [ -.- | 4.1 ] - +
Gallery can get sensible a name (e.g. mygallery.thm).
[ -.- | 4.1 ] - +

Galleries are created at compile time from a flat list 
of files.  [ -.- | 4.1 ] - +

New Gallery Images (IBM Symphony).  [ 4.0 | 4.1 ] + + ▸

Respect accessibility requirements, but also let dark 
theme users have decent default colors.   [ -.- | 4.2 ] - +

Native rendering toolbars background OSX.  [ -.- | 4.3 ] - +
Initial HiDPI support.   [ -.- | 4.3 ] - +
Large icons by default on Windows, as they are on 
Linux and Mac OS.  [ -.- | 4.4 ] - +
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2-10 pdf handling

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

pdf handling AOO 4.1 LO 4.4

Directly digital signed PDF's during the export. The 
Windows built-in certificate functionality is used to 
store your certificates for signing.  [ -.- | 4.4 ]

- ++
▸

Better handling of export to pdf for hidden slides.  
Per default, hidden slides are excluded, but they can
be included per check-box.  [ -.- | 3.5 ] 

- +

PDF Export user interface with Watermark option.  
[ -.- | 3.6 ]    - +

PDF Import, Presenter Console and Python Scripting 
Provider are no longer bundled extensions but core.
[ -.- | 4.0 ] 

- +

Always embedding the standard PostScript core font
set in PDF exports.  [ -.- | 4.2 ]    - +

Enhanced chart visualisation - better quality render-
ing / print and PDF export of charts.  [ 4.1 | 4.0 ] + +

2-11 cleanup

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

cleanup AOO 4.1 LO 4.4

Initial port added to gtk3, and hence via Broadway a 
web office prototype.   [ -.- | 3.5 ] - +

The unused toolbar menus are removed, and the 
indication of hidden items is updated.   [ 3.4 | 3.5 ] ++ + ▸

Cleanup of 3D borders in rulers and status bars.  
Improved look through the background gradient.   
[ -.- | 3.6 ] 

- +

No dictionary choice when there is only one active.   
[ -.- | 3.6 ] - +

End of 72 pt limitation of the Increase font button.   
[ -.- | 4.3 ] - +

Font, Font size and alignment formatting removed 
from context menu in Writer.   [ -.- | 4.4 ] - +
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2-12 miscellaneous

2 INTERFACE, LOOK, DIALOGS, ETC. (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

miscellaneous AOO 4.1 LO 4.4

Change the password in open encrypted document. 
[ -.- | 3.4 ] - +

Typing "http:" no longer auto-capitalizes.  [ -.- | 3.4 ] - +
Redesigned all range name dialogs.  [ -.- | 3.5 ] - + ▸

Pleasantly adapting to Linux mouse pointer themes. 
[ 4.0 | 3.4 ]  + +

Rotate through case changes.  [ -.- | 3.4 ] - +
Natural Sorting in Menu list.  [ -.- | 3.5 ]  - +
Macro recording activation with a separate option.  
[ -.- | 3.6 ] - +

Added "Support for assistive technology tools" to 
installation process.  [ -.- | 3.6 ]  - +

Non-native template files possible files in the 
templates management interfaces. Templates from 
other office suites are now handled like ODF ones.  
[ -.- | 4.0 ] 

- +

Support Firefox Personas in LibreOffice.  [ -.- | 4.0 ]  - ++ ▸

Firefox themes now apply also to bottom toolbars.  
[ -.- | 4.4 ] - +

Unify Popup menu option Save Graphic… from 
Writer and Save as Picture… from Draw and Impress
to Save Graphic….  [ -.- | 4.0 ]  

- +

Possibility to select interpolation algorithm.  [ -.- | 4.0 ] - +
GStreamer 1.0 support added and re-factor existing 
gstreamer code.   [ -.- | 4.0 ] - +

New ICU Regular Expression Engine.  [ 3.4 | 4.0 ] + +
Smiling Smiley.  [ -.- | 4.2 ]  - +
An Expert Configuration functionality has been 
added to the Options tab.  [ -.- | 4.2 ]  - +

On Windows there is a new experimental 
accessibility bridge supporting IAccessible2 (IA2), 
based on code from IBM.  [ -.- | 4.2 ]  

- +

DOCX import now has a progressbar.  [ -.- | 4.3 ]  - + ▸

Added new, specialized accesiibility roles for specific 
text, spreadsheet and presentation documents.  
[ -.- | 4.3 ] 

- +

Improve mapping ATK and LibreOffice roles.  [ -.- | 4.3 ] - +
IAccessible2 is now the only assistive technology 
support option on Windows.  [ 4.1 | 4.3 ]  + +

About dialog locale Wikipedia logo v3.svg.  [ -.- | 4.4 ]  - +
UI text improvements.  [ -.- | 4.4 ] - +
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3. Writer

3-01 direct view & entry

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

direct view & entry AOO 4.1 LO 4.4

Internationalized font previews in a drop-down 
selector.  [ -.- | 3.4 ] - ++ ▸

Changing text boundaries is edited.  [ -.- | 3.5 ] - +
Better page breaks indicators.  [ -.- | 3.5 ] - +
Displaying non-printable characters on end of line.  
[ -.- | 3.5 ] - +

Display bitmap image resolution in PPI (pixel/inch) in
Format - Picture - Crop tab page.  [ -.- | 3.5 ] - +

The style dropdown now has a split menu to edit or 
update the current style.  [ -.- | 4.4 ] - ++
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3-02 handi

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

handi AOO 4.1 LO 4.4

Better UI for Header and Footers handling.  [ -.- | 3.5 ] - + ▸

Quickly edit or remove headers and footers.  [ -.- | 3.5 ] - +
Pressing "Ctrl+[" will decrease or "Ctrl+]" will increa-
se the font size of the selected text.  [ -.- | 3.6 ] - +

Table AutoFormats record extra table-level proper-
ties like Break, Repeat heading, Merge line styles, 
etc...  [ -.- | 3.6 ]

- ++

Clicking fields selects them instead of placing the 
cursor before them.  [ -.- | 4.0 ] - +

Print comment next to the text in the right margin as
they appear on screen. Pages are scaled down to fit 
on the underlying paper size.  [ -.- | 4.3 ]

- ++
▸

Wildcards in autocorrection.  [ -.- | 4.2 ] - +
Select-All works in the special situation when the 
document starts with a table.  [ -.- | 4.2 ] - +

Hide or delete styles in the Style and Formatting 
window.  [ -.- | 4.2 ] - +

Master Document Templates, they create a Master 
Document with the same initial content as the 
Template.  [ -.- | 4.4 ] 

- +

In-place editing of input fields.  [ 4.1 | 4.2 ] + +
Option to change the currently selected image to 
another graphic via the context menu, reaching 
feature parity with Impress and Draw.  [ -.- | 4.4 ]

- ++
▸
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3-03 lay-out & style

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

lay-out & style AOO 4.1 LO 4.4

Linux Libertine typeface updated: ttfautohint, better 
small cap.s, double stroke and italics.  [ -.- | 3.5 ]  - + ▸

Liberation fonts included in Windows builds. [ -.- | 3.5 ] - +
Four new open-source font families: Open Sans 
(Ascender), PT Serif (ParaType), Source Code Pro and
Source Sans Pro (Adobe).  [ -.- | 4.0 ]  

- +

Allow extra word boundary characters. Overriding 
long dash (—) and short dash (–) for counting words.
[ -.- | 4.0 ] 

- +

Improved Footnote and footer comment handling.  
[ -.- | 4.1 ] - +

Writer textframes support gradient as background. 
[ -.- | 4.1 ] - +

Comments to text ranges over multiple paragraphs. 
[ -.- | 4.1 ] - +

Easy images rotation 90 degree increments.  [ -.- | 4.1 ] - + ▸

Typesetting: fixed line breaking at hard hyphens and
at words before punctuation marks.  [ -.- | 4.2 ] - +

Format one or more characters with a border. Sup-
ports: odt, html, doc, docx, rtf.  [ -.- | 4.2 ] - +

Vertical alignment of text supported for text frames. 
[ -.- | 4.3 ] - +

Proportional Image scaling by default, free resizing 
is available holding  Shift.  ⇧ [ -.- | 4.3 ] - ++

Added Caladea and Carlito fonts to the installation, 
with same metrics and proportions as Microsoft’s 
Cambria and Calibri.  [ -.- | 4.4 ]

- ++

Character properties of all comments can be set at 
the same time now in order to reformat all.  [ -.- | 4.3 ] - +

16bit (65,535) characters limitation of Writer para-
graphs is raised to 32bit (2,147,483,647).  [ -.- | 4.3 ] - ++

Writer shapes can now have a Textbox, so that com-
plex content and full drawinglayer geometry for a 
shape work at the same time.  [ -.- | 4.4 ]

- ++
▸

Dash replacement between numbers, wildcard pat-
terns in the default Autocorrect lists. Also in Im-
press, Calc and Draw.  [ -.- | 4.4 ]

- +
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3-04 fresh look

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

fresh look AOO 4.1 LO 4.4

New gradient/drop-shadow to highlight writer pa-
ges, with configurable colors in the options.  [ -.- | 3.4 ] - +

Text Boundaries shown depending on the choice to 
display unprintable characters.  [ -.- | 3.6 ] - +

On Windows, modern IMEs show their suggestion 
windows at easy-to-read position.  [ -.- | 4.1 ] - + ▸

Comments bar toggling with a button in the ruler.  
[ -.- | 4.1 ] - +

Non-printing Characters in "Solarized blue".  [ -.- | 4.3 ] - +
Reorganized “Standard” and “Formatting” toolbars,  
removing features and replace more commonly 
used ones.  [ -.- | 4.4 ]  

- +

Page number styles in the statusbar are more easy 
to understand for complexer situations.  [ -.- | 4.4 ] - + ▸

Tooltips were added to all elements of the statusbar.
[ -.- | 4.4 ] - +

3-05 word & character counting

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

word & character counting AOO 4.1 LO 4.4

The word count dialog is modeless and updates as 
you type.  [ -.- | 3.5 ] - + ▸

Update Word Count. Word Count now on status bar.
[ -.- | 3.6 ] - +

Word and character count got thousand separators. 
[ -.- | 4.4 ] - +

Asynchronous word-count. For large documents 
don't defer rendering the document and status bar 
until we've word-counted it.  [ -.- | 4.1 ] 

- +
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3-06 labels

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

labels AOO 4.1 LO 4.4

Existing user defined labels are automatically 
extended with form size.  [ -.- | 3.6 ] - +

The form size for label can be entered/modified in 
the wizard dialog.  [ -.- | 3.6 ] - + ▸

Label / Business Card Wizard Extension of label defi-
nitions with form and size. Labels are centered co-
rrectly on the form.  [ -.- | 3.6 ]

- ++

1700+ predefined label definitions are modified to 
include the form size, obsolete definitions removed. 
[ -.- | 3.6 ] 

- ++

Label printing positioning fixed.  [ -.- | 3.5 ] - +
Recalculation of label positions. Definitions with a 
gap between labels, wider than the right margin, 
now produce correct documents.  [ -.- | 3.6 ]

- +

3-07 embedding

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

embedding AOO 4.1 LO 4.4

Embedding images into HTML files enables sending 
merge mails with images in HTML format.  [ -.- | 4.2 ] - ++

Enable attaching comments to document text 
ranges.  [ -.- | 4.0 ] - +

Import and export of nested comments in the odf, 
doc, docx and rtf filters.  [ 4.1 | 4.3 ] ++ ++ ▸

Auto-generated tables of contents contain hyper-
links to the relevant pages by default.  [ -.- | 3.5 ] - +
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3-08 LibreLogo

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

LibreLogo AOO 4.1 LO 4.4

"LibreLogo" vector graphics with Logo toolbar and 
interpreter.  [ -.- | 4.0 ] - ++ ▸

LibreLogo PENCAP/LINECAP feature. Stable batch 
generation of cropped SVG images. Optional looping
of SVG animations. SVG image path of PICTURE is 
relative to the path of the document.  [ -.- | 4.2 ]

- +

PENTRANSPARENCY, FILLTRANSPARENCY to set 
transparency after PENCOLOR, FILLCOLOR usage.  
[ -.- | 4.3 ]

- +

Color and transparency gradients are supported via 
FILLCOLOR and FILLTRANSPARENCY commands.  [ -.- 
| 4.3 ]

- +

3-09 track changes

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

track changes AOO 4.1 LO 4.4

New buttons in the Track Changes toolbar, along 
with a new set of icons.  [ -.- | 4.4 ] - + ▸

Menu item renamed from 'Changes' to the 
commonly recognized 'Track Changes'.  [ -.- | 4.4 ] - +

Default behavior 'Accept Change' and 'Reject Chan-
ge' in the context menu changed to automatically 
jump to next change.  [ -.- | 4.4 ]

- +

Keyboard shortcut Ctrl+  Shift+E now associates ⇧
with the recording of track changes.  [ -.- | 4.4 ] - +

Spellcheck popup menu allows for for change 
tracking operations.  [ -.- | 4.2 ] - +
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3-10 miscellaneous

3 writing, style, templates, etc. (since version 3.4) OFFICE SUITE ILLUSTRATION

miscellaneous AOO 4.1 LO 4.4

Paintbrush format can apply automatic formatting 
for characters, different from those in the 
paragraph.  [ -.- | 3.6 ] 

- +

New Default Template based on feedback from 
discussions.  [ -.- | 4.2 ] - + ▸

AutoCorrection of border enhanced: differences are 
more visible.  [ -.- | 4.2 ] - +

Cross references of headings don't contain footnote 
nrs in headers, tips of references and dialog Fields.  [
-.- | 4.2 ] 

- +

Increase/decrease font functionality to drawing 
objects.  [ -.- | 4.3 ] - +

Multiple relations supported for relative size of text 
frames.  [ -.- | 4.3 ] - + ▸

Line numbering can be enabled in a single location, 
in addition to the existing per-style method.  [ -.- | 4.4 ] - +

Improved spacing between elements at the status 
bar for low res screens.  [ -.- | 4.4 ] - +

Addition of a 'Wrap Text' button at the status bar.  
[ -.- | 4.4 ] - +

Bookmarks in Navigator can be named using any 
character that is accepted in HTML anchor names.  
[ -.- | 4.4 ]

- +

Default “ASCII arrow” autocorrect patterns (->, <-): A-
>B->C  A B C improved.  → → → [ -.- | 4.4 ] + +

Autocorrect replacements of arbitrary suffixes and 
prefixes. Add .*text.*-like patterns to correct 
common typing errors within words.  [ -.- | 4.4 ] 

- +
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4. Calc

4-01 pivottables / datapilots

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

pivottables / datapilots AOO 4.1 LO 4.4

DataPilot is renamed Pivot Table.  [ 3.4 | 3.4 ] + +
it is now possible to use a named range as the data 
source. This allows addition of new rows to the data 
source and updating, without manually changing the
data source range in the dialog.  [ -.- | 3.4 ]

- ++

Pivot Table: Support multiple selections in page field
of pivot table.  [ -.- | 4.0 ] - ++ ▸

Support for unlimited number of fields: no limitation
to 8 column/row/data fields and 10 page fields.  
[ -.- | 3.4 ]

- ++

The internal implementation of DataPilot has been 
re-worked in order to fix several regressions 
especially with regard to refresh DataPilot tables.  
[ -.- | 3.4 ]

- +

Pivot Table layout improvement "Data" field is now 
on columns by default, and can be moved to rows if 
needed. It helps to faster generate of useful pivot 
tables from large data sources.  [ -.- | 4.3 ]

- + ▸ 
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4-02 new functions

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

new functions AOO 4.1 LO 4.4

Named ranges in sheet-local scope instead of entire 
document. The named range dialog has been 
modified to reflect this.  [ -.- | 3.4 ]

- +
▸ 

New Calc Functions BITAND, BITOR, BITXOR, BITR-
SHIFT and BITLSHIFT (ODF 1.2 specification).  [ -.- | 3.5 ] - +

New Calc Functions SEC, CSC, SECH and CSCH, as 
declared in the ODF 1.2 specification.  [ -.- | 3.5 ] - +

New spreadsheet functions (ODF OpenFormula).  
[ 3.4 | 3.6 ] + ++  

DATEDIF.  [ -.- | 3.6 ] - +
IMTAN, IMSEC, IMCSC, IMCOT, IMSINH, IMCOSH, 
IMSECH and IMCSCH.  [ -.- | 3.6 ] - +

Now in spreadsheet: Count the number of selected 
cells.  [ -.- | 4.1 ] - + ▸ 

Available: AVERAGEIF, SUMIFS, AVERAGEIFS and 
COUNTIFS as defined in ODF OpenFormula.  
[ 4.0 | 4.0 ]

+ +

Import color scales and data bars from xlsx. [ -.- | 4.0 ] - +
Available:  IFERROR and IFNA (ODF OpenFormula).  
[ -.- | 4.0 ] - +

Re-implemented RAND() function with better 
random number generation algorithm.  [ 4.0 | 4.0 ] + +

Pricing Add-In containing spreadsheet functions for 
option pricing in particular barrier (OPT_BARRIER(...))
and touch (OPT_TOUCH(...)) options.  [ -.- | 4.0 ]

- +

XOR as defined in ODF OpenFormula.  [ -.- | 4.0 ] - +
NUMBERVALUE as defined in ODF OpenFormula.  
[ -.- | 4.1 ] - +

SKEWP as defined in ODF OpenFormula.  [ -.- | 4.1 ] - +
Random number generation.  [ -.- | 4.2 ] - + ▸ 

WEBSERVICE and FILTERXML spreadsheet functions 
for access to web data.  [ -.- | 4.2 ] - +

LEFTB, LENB, MIDB and RIGHTB working on DBCS 
double byte character strings.  [ 4.0 | 4.2 ] + +

CHISQ.DIST, CHISQ.DIST.RT, CHISQ.INV, 
CHISQ.INV.RT,CHISQ.TEST.  [ -.- | 4.2 ] - +

At random number generation user can optionally 
limit the number of decimal places in generation.  
[ -.- | 4.3 ]

- +
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4-03 sheets and tabs

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

sheets and tabs AOO 4.1 LO 4.4

Redesigned Move/Copy Sheet dialog to improve its 
ergonomics.  [ -.- | 3.4 ] - ++ ▸ 

Specify the initial number of sheets in new 
documents.  [ -.- | 3.5 ] - +

New option to specify a custom sheet name prefix in
new documents.  [ -.- | 3.6 ] - +

Improved error message for invalid sheet name.  
[ -.- | 3.6 ] - +

 Default number of sheets has been changed to 1.  
[ -.- | 3.6 ] - +

Right-click context menu on bottom left scrollbar 
arrows to switch sheets.  [ -.- | 4.2 ] - +

When expanding the space available for sheet tabs 
make better use of that.  [ -.- | 4.3 ] - +

Sheet tabs (Calc) and layer tabs (Draw) are moved to
an independent row and are no longer displayed 
next to the horizontal scrollbar.  [ -.- | 4.4 ] 

- +
▸ 

The right-click context menu that appear for manag-
ing sheets got icons for sheet operations.  [ -.- | 4.4 ] - +

4-04 direct view and entry

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

direct view and entry AOO 4.1 LO 4.4

New multiline inputbar.  [ -.- | 3.5 ] - ++ ▸ 

Differentiated different error messages in CSV im-
port handling.  [ -.- | 3.6 ] - +

XML Source dialog to quickly import arbitrary XML 
content.  [ -.- | 4.0 ] - +

Smarter highlighting of cell in a formula – Border 
highlight on multiple instances of the same cell, 
when selecting a formula, got same color.  [ -.- | 4.3 ]

- +
▸ 

When selecting cells, the number of selected rows 
and columns is shown in the status bar.  [ -.- | 4.3 ] - +

Implemented 'Find All' also in case of 'search in all 
sheets' option - creates a dialog describing matching
cells.  [ -.- | 4.2 ]

- +

Comparing LibreOffice and ApacheOpenOffice 38 work-in-progress/version 20150318



4-05 autofilter

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

autofilter AOO 4.1 LO 4.4

Possibility to set autofilter per sheet without 
manually creating named database ranges prior to 
setting autofilter. Previously Calc only supported 
one autofilter per document.  [ -.- | 3.4 ]

- +

Calc allows sorting of data from the autofilter menu. 
[ -.- | 3.6 ] - ++ ▸ 

Support "type-ahead" search in the autofilter popup.
Possibility to search for specific entry via key input.  
[ -.- | 4.0 ]

- +

  

4-06 conditional formatting

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

conditional formatting AOO 4.1 LO 4.4

New dialogs for conditional formats to support color
scales and data bars.  [ -.- | 3.6 ] - ++ ▸

Unlimited number of rules for conditional 
formatting.  [ -.- | 3.5 ] - +

Export conditional formatting to .xlsx.  [ -.- | 3.6 ] - +
Improved conditional format dialogs.  [ -.- | 4.0 ] - +  

New conditional formats:  Date formats, Top/Bottom
rules, String rules.  [ -.- | 4.0 ] - + ▸
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4-07 number import and csv handling

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

number import and csv handling AOO 4.1 LO 4.4

Added a "Save cell formulas instead of calculated 
values" option to CSV export.  [ -.- | 3.6 ] - + ▸ 

Handling of broken CSV files that are not following 
RFC 4180 quote rules.  [ -.- | 3.6 ] - +

Import numbers in scientific notation without having
to check "import special numbers".  [ -.- | 3.6 ] - +

Better initial default separators, comma, semicolon 
and tab.  [ -.- | 3.6 ] - +

Handle lines with more than 64k characters.  [ -.- | 3.6 ] - +

4-08 formula, calculations & statistics

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

formula, calculations & statistics AOO 4.1 LO 4.4

Detailed configuration options for formula calcula-
tion. You can now configure the reference syntax for
built-in function: INDIRECT.  [ -.- | 3.6 ] 

- ++
▸

Multiple subtotals on a single sheet.  [ -.- | 3.4 ] - ++
Remove limitation of 3 sort entries.  [ -.- | 3.6 ] - ++
New configuration option to toggle handling of emp-
ty strings when used in arithmetic expression.  
[ -.- | 4.0 ]

- +

Statistics functions Data  Statistics (alternative to ▸
Excel's Add-in "Analysis ToolPak").  [ -.- | 4.2 ] - +

in Detailed calculation settings the user can select 
how textual cell content shall be treated in 
arithmetic operations.  [ -.- | 4.3 ] 

- +

Extend formula range by draging from all corners.  
[ -.- | 4.2 ] - + ▸ 

In Statistics Wizard Data  Statistics: addition of Two ▸
factor Analysis of Variance (ANOVA).  [ -.- | 4.3 ] - +

Converting formula cells into static values (via menu 
Tools  Cell Contents  Formula to Value).  ▸ ▸ [ -.- | 4.4 ] - +

Added Quartile in Descriptive statistics.  [ -.- | 4.4 ] - +
Added z-test.  [ -.- | 4.4 ] - +
Added Chi square test.  [ -.- | 4.4 ] - +
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4-09 charts

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

charts AOO 4.1 LO 4.4

Open and closed lines smoothed with “B-Spline” go 
through points interpolating between them.  [ -.- | 3.5 ] - + ▸

Adding and Removing default colors for charts from 
Tools->Options->Charts->Default Colors.  [ -.- | 3.4 ] - +

Closed lines which are smoothed using a “Cubic 
Spline” are completely rounded.  [ -.- | 3.5 ] - +

Support for X errorbars in scatter and bar charts, im-
port/export to .xls and .ods when using ODF 1.2.  
[ -.- | 3.6 ] 

- +

Support color scales and data bars. Import from 
.xlsx and import/export from/to .ods in ODF 1.2.  
[ -.- | 3.6 ]

- +

Automatically rotate chart axis labels if they are 
overlapping. Improved detection of overlap labels.  
[ -.- | 4.0 ]

- +

Automatically Rotate Chart Axis.  [ 3.4 | 4.0 ] + +
Trend lines enhancement: Moving average lines.  
[ -.- | 4.2 ] - + ▸

Exporting of a single chart as image (PNG, JPG).  
[ -.- | 4.0 ] - +

Charts export to vector graphics (e.g. SVG, PDF).  
[ -.- | 4.1 ] - +

Add a Stepped Lines line type to Line and XY 
(Scatter) charts.  [ -.- | 4.1 ] - +

Toolbar buttons for vertical/horizontal grids change 
behavior to variate grid between major, major&mi-
nor and off.  [ -.- | 4.2 ]

- +

Support more than one trend line per series.  
[ -.- | 4.2 ] - +

Force intercept for trend lines.  [ -.- | 4.2 ] - +
Extrapolation of trend lines.  [ -.- | 4.2 ] - +
Polynomial trend lines.  [ -.- | 4.2 ] - +
Added property mapping functionality for charts, 
allowing to change data series properties based on 
spreadsheet values.  [ -.- | 4.3 ]

- +
▸
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4-10 miscellaneous

4 SPREADSHEETS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

miscellaneous AOO 4.1 LO 4.4

Improvement of the drawing layer on re-positioning 
and re-sizing of drawing objects.  [ -.- | 3.4 ] - +

Allow pasting a single cell range to multiple destina-
tion ranges.  [ -.- | 3.5 ] - +

Additional data point markers, suitable for the 'stan-
dard markers' in the ODF 1.2 specification. Better 
mappingmarkers for charts in xls files.  [ -.- | 3.5 ]

- +

Remembering previous values and launches in an 
error message notifying link update failure.  [ -.- | 3.5 ] - +

Allow starting of cell edit with the content of the cell 
above it as its initial content. It is bound to the Ctrl+' 
(single quote) key by default.  [ -.- | 4.3 ]

- +
▸

"Ctrl+D" fills down in more familiar ways, with con-
tents of the cell above if no cell is selected, and, fil-
ling down multiple cells with larger selections.  
[ -.- | 3.6 ] 

- +

Save settings Text Import Dialog for Text to Columns
and Paste Unformatted Text from Clipboard. 
 [ -.- | 4.0 ]

- +

Clear Name specialties: (in parentheses the Calc en-
US UI name) [in brackets the ODFF name].  [ -.- | 4.1 ]

▸

Embedding fonts in a Calc spreadsheet.  [ -.- | 4.1 ] - +
Prevent increase indent from running outside a cell. 
[ -.- | 4.2 ] - +

Improved CRITBINOM spreadsheet function to han-
dle large sample quantities.  [ -.- | 4.2 ] - +

Enable CoinMP solver (together with lpsolve solver). 
[ -.- | 4.3 ] - +

In “Standard” and “Formatting” toolbars are uncom-
monly used commands replaced by frequent ones.  
[ -.- | 4.4 ]

- +

Local help page button (Edit>Fill> Random Number).
[ -.- | 4.4 ] - +

Local help page button for Calc in Data> Statistics.  
[ -.- | 4.4 ] - +

Local help entries for various functions.  [ -.- | 4.4 ] - +
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5. Impress and Draw

5-01 masterpages

5 PRESENTATIONS AND DRAWINGS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

masterpages AOO 4.1 LO 4.4

10 new Impress master pages.  [ -.- | 3.6 ] - + ▸

New field: Page Title in Insert  Field  Page Title.  ▸ ▸
[ -.- | 4.4 ] - +

In Slide Master view, the text of the presentation ob-
ject previews is now read-only. To add or hide a level
to the outline numbering preview, use the context 
menu on the last line.  [ -.- | 4.4 ]  

- +

Toggling bullets on and off in slide master view in 
the outline preview via "Bullets On/Off" shows the 
effect in the normal view.  [ -.- | 3.5 ]  

- +

5-02 controlling

5 PRESENTATIONS AND DRAWINGS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

controlling AOO 4.1 LO 4.4

Presenter Console features a "Exchange Screen 
Images" button to work around when the screen 
picks for Presenter Console  instead of the speaker's
laptop.  [ -.- | 3.5 ]  

- +
▸

More correct detecting the external display and put-
ting the presenter console on local display.  [ -.- | 3.6 ]  - +

OpenGL transitions: Implemented and enabled for 
Windows.  [ -.- | 4.4 ]   - +

Improved implementation based on new OpenGL 
framework in vcl for Linux, Windows and OS X.  
[ -.- | 4.4 ]  

- +

Added Impress Remote for controlling the presen-
tation.  [ -.- | 4.4 ]  - +
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5-03 direct view and entry

5 presentations and drawings (since version 3.4) OFFICE SUITE ILLUSTRATION

direct view and entry AOO 4.1 LO 4.4

Better handling of custom animation list. Just scroll 
to newly added animations, stay with items when 
they are moved up or down and keep animations in 
view when changing their properties.  [ -.- | 3.5 ] 

- +

The "Insert Movie and Sound" dialog got a "Link" 
checkbox, enabling the embedding of media files 
into ODF package based documents.  [ -.- | 3.5 ]  

- +

Start Impress without wizard (it can be run 
manually).  [ -.- | 3.5 ]  - +

Visual clue in Slide Sorter when a Slide has a 
Transition or Animation(s).  [ -.- | 4.0 ]  - + ▸

The side bar is enabled by default.  [ 4.0 | 4.2 ]  + +
Improve quality of page previews in Draw/Impress 
with supersampling.  [ -.- | 4.2 ]  - +

Adding icons to slides having custom animation or 
transition set, in presenter view, makes easier to 
present the whole content of the slides.  [ -.- | 4.2 ] 

- +

New Custom Animation toolbar.  [ -.- | 4.2 ] - + ▸ 

Possibility to distinguish between selected and 
unselected slides when the mouse over highlight 
activates.  [ -.- | 4.3 ]  

- +

Reorganized view menu to better unify its items 
similar to Writer and Calc.  [ -.- | 4.4 ]  - +

Default toolbars are reorganized to bring frequent 
used features to the toolbars.  [ -.- | 4.4 ]  - +

Creation of a new zoom mode button that is able to 
zoom in, zoom out and pan (select displayed area) 
with the use of Ctrl and  Shift.  ⇧ [ -.- | 4.4 ]  

- +
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5-04 handi

5 PRESENTATIONS AND DRAWINGS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

handi AOO 4.1 LO 4.4

The state of the sidebar pane in Impress is now 
remembered.  [ -.- | 4.0 ]  - +

Option to disable the bundled Presenter Console, 
for a smoother OpenLP integration.  [ -.- | 4.1 ]   - +

Add an icon to the statusbar to allow fitting the 
current slide to window with a single click.  [ -.- | 4.3 ]   - + ▸

New rows/columns in tables inherit the style of the 
current row/column , instead of using default values.
[ -.- | 4.4 ]   

- +

In Slide Master view elements can now be removed 
by direct deletion of the matching placeholder in the
Master View preview.  [ -.- | 4.4 ]  

- +

5-05 graphics

5 PRESENTATIONS AND DRAWINGS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

graphics AOO 4.1 LO 4.4

Circles and Ovals toolbar from Impress now also 
available in Draw.  [ -.- | 4.0 ] - + ▸

Elliptical arcs in path are properly imported and 
rendered.  [ 4.0 | 3.5 ]  + +

The standard palette has got some new line ends, 
mostly unfilled ones, useful for e.g. UML diagrams.  
The line width inside the marker scales together 
with the marker width.  [ -.- | 3.5 ] 

- +

Shear transforms for GraphicObjects, and shear + 
properties for OLE Objects.  [ 4.0 | 4.0 ] + +

Dialog for Smooth image filter, possibility to select 
the radius (strength) of smoothing/blurring.  [ -.- | 4.0 ] - +

Added "Edit graphics with External Tool" to Calc, 
Impress and Draw.  [ -.- | 4.0 ]  - +

Adding rounded caps (ends) to line.  [ 3.4 | 4.0 ]  + + ▸

Draw supports background color for text in frames 
and captions.  [ -.- | 4.4 ]  - +

Paper size specified in page formatting with printing.
[ -.- | 4.4 ]  - +

You can move only the point next to the rectangle in 
"line callout" drawings, with  Shift key pressed.  ⇧ [ -.- 
| 4.4 ]  

- +

Tiled rendering Wikipedia logo v3.svg for performan-
ce when navigating documents in mobile devices.  
[ -.- | 4.4 ] 

- +
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5-06 miscellaneous

5 PRESENTATIONS AND DRAWINGS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

miscellaneous AOO 4.1 LO 4.4

Improve HTML export with an image thumbnail 
gallery of the slides on the contents page.  [ -.- | 3.4 ] - + ▸

Added widescreen format for Impress slideshows.  
[ -.- | 3.6 ] - ++

Multi-image support in ODF allowing a bitmap + SVG
representation eg.  [ 4.0 | 4.0 ] + +

Embedding fonts in a Impress presentation file.  
[ -.- | 4.1 ] - ++

Table Style « turquise » in Impress correction.  
[ -.- | 4.2 ] - +

Hidden slides are no longer included in the “Number
of pages” counting field, to avoid confusion.  [ -.- | 4.3 ] - +

Create easy slideshows from a series of pictures 
with the “Photo Album” feature.  [ -.- | 4.1 ] - + ▸

LibreOffice supports inserting 3D models in the glTF 
format into presentations (using libgltf).  [ -.- | 4.3 ] - +

Limited support for 3D models in *.dae and *.kmz 
formats (using collada2gltf).  [ -.- | 4.3 ] - +

It is now possible to save an Impress/Draw file read-
only and require a password to modify it.  [ -.- | 4.4 ] - +
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6. Base

6 Base

6 DATABASES, QUERIES, FORMS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

Base AOO 4.1 LO 4.4

Integrated PostgreSQL native driver. It works well 
and much faster than alternatives such as JDBC or 
ODBC for basic features.  [ -.- | 3.5 ] 

- ++

Change AutoFilter in forms. Values are no longer 
treated as patterns. An AutoFilter on "A*" will now  
match only the exact value "A*".  [ -.- | 4.0 ]

- +

Limiting the results of a query by using the 'Limit' 
combobox on the Query Design Toolbar.  [ -.- | 4.1 ] - + ▸

New Query Properties Dialog in Query Design View 
for adding limit and distinct values properties.  
[ -.- | 4.1 ]

- +

Query Properties Toolbar Dialog can open from 
Query Design Toolbar.  [ -.- | 4.1 ] - +

Experimental Firebird SQL connector for LibreOffice 
Base.  [ -.- | 4.2 ] - ++

LibreOffice bundles new versions of Access2Base.  
[ -.- | 4.3 ] - +

7. Math

7 Math

7 FORMULAS AND MATHEMATICS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

Math AOO 4.1 LO 4.4

Format dialogues (Font, Font Size and Spacing) and 
the Symbols dialogue got a button linking to Help.  
[ -.- | 3.6 ] 

- ++
▸

New "does not exist"  symbol.  ∄ [ -.- | 3.5 ] - +
New symbols for Games theory.  [ -.- | 3.5 ]  - +
Import / export support for native RTF math 
expressions.  [ -.- | 4.0 ] - +

New Elements docking windows added.  [ -.- | 4.1 ] - +
Formula editor: Make use of ZoomSlider in Math.  
[ -.- | 4.2 ] - +

Formula editor: Auto Closing of brackets.  [ -.- | 4.2 ]  - +
Improved MathML Export.  [ -.- | 4.2 ]  - +
Math supports the basic 16 HTML colors.  [ -.- | 4.4 ] - + ▸

Colors can be inserted from Elements docked bar.  
[ -.- | 4.4 ]  - +
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8. Localization

8-01 new languages

8 WORLDWIDE NATIVE USE AND TOOLS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

new languages AOO 4.1 LO 4.4

Portuguese (Angola) locale data (pt_AO).  [ -.- | 3.4 ]  - +
Arabic, Aragonese, Belarusian, Bengali, Breton, Bul-
garian, Scottish Gaelic, Greek, Gujarati, Hindi, Latvi-
an, Brazilian Portuguese, European Portuguese, Sin-
hala, and Telugu spelling dictionaries.  [ 4.0 | 3.5 ] 

+ +

Initial support for UI languages, Luxembourgish (lb) 
and Tatar (tt).  [ -.- | 3.5 ] - + ▸

Added en-MW locale data.  [ -.- | 3.6 ] - +
Added myv-RU locale data.  [ -.- | 3.6 ] - +
Files for axk_CG beq_CG bkw_CG bvx_CG dde_CG 
ebo_CG iyx_CG kkw_CG kng_CG ldi_CG mdw_CG 
mkw_CG ngz_CG njx_CG njy_CG puu_CG sdj_CG tek-
_CG tsa_CG tyx_CG vif_CG xku_CG yom_CG.  [ -.- | 4.0 ]  

- +

Beembe (beq), Bekwel(bkw), Kituba (mkw), Lari (ldi), 
Mbochi (mdw), Teke-Ibali (tek), Teke-Tyee (tyx), and 
Vili (vif) languages (Republic of Congo). With hunspell
spell checker dictionaries.  [ -.- | 3.4 ]  

- +
▸

Added [en-GB-oed] grandfathered tag for "English, 
Oxford English Dictionary spelling" to language list.  
Northern/southern Kurdish in Latin, Syria and Arabic
script.  [ -.- | 4.2 ]  

- +

Added French (Burkina Faso) [fr-BF] and locale data. 
[ -.- | 4.2 ]  - +

Bamanankan/Bambara_Mali [bm-ML] locale data.  
[ -.- | 4.2 ]  - +

Puinave_Colombia [pui-CO] locale data.  [ -.- | 4.2 ]  - +
Arabic_UAE [ar-AE] and Arabic_Kuwait [ar-KW] locale 
data referrers for AED and KWD currencies.  [ -.- | 4.2 ] - +

Added Maninkakan, Eastern, Latin [emk-Latn-GN].  
[ -.- | 4.3 ]  - +

Added Avar [av-RU].  [ -.- | 4.3 ]  - +
Avaiable: Cree, Plains, Latin [crk-Latn-CN] and 
Syllabics [crk-Cans-CN].  [ -.- | 4.3 ]   - +

Added Lengo [lgr-SB] locale data.  [ -.- | 4.3 ]  - +
Added Moore [mos-BF] locale data.  [ -.- | 4.3 ]  - +
French (Côte d'Ivoire) [fr-CI] locale data.  [ -.- | 4.3 ]  - +
French (Mali) [fr-ML] locale data.  [ -.- | 4.3 ]  - +
French (Senegal) [fr-SN] locale data.  [ -.- | 4.3 ]  - +
French (Benin) [fr-BJ] locale data.  [ -.- | 4.3 ]    - +
French (Niger) [fr-NE] locale data.  [ -.- | 4.3 ]  - +
French (Togo) [fr-TG] locale data.  [ -.- | 4.3 ]  - +
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8-02 spell and grammar

8 WORLDWIDE NATIVE USE AND TOOLS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

spell and grammar AOO 4.1 LO 4.4

Updated German spell check dictionaries, hyphena-
tion and thesaurus.  [3.4 | 3.4 ] + +

Duden Korrektor extension 5.0 and 6.0 added.  
[ 3.4 | 3.5 ] + +

Possessive genitive case and/or partitive month na-
mes if provided by a locale’s locale data.  [ -.- | 3.5 ] - +

Corrections to Polish [pl-PL], Portuguese [pt-PT and 
pt-BR], Slovenian [sl-SI], and Latin [la-VA] locale data,
esp. date formats.  [ -.- | 3.5 ]

- +

Bundled LightProof grammar checkers for English, 
Hungarian, and Russian.  [ -.- | 3.5 ] - +

Checks: punctuation, a/an article, word spacing, pa-
ragraph capitalization, simple word duplication etc..  
[ -.- | 3.5 ]

- +

Longer explanations, using Wikipedia articles.  
[ -.- | 3.5 ] - +

Translated key names on Windows for Asturian,  Ca-
talan, Estonian, Slovenian and Spanish. Translated 
key names on Linux for Slovenian.  [ -.- | 4.0 ] 

- +
▸

Optional: more grammar checks, measurement con-
version, thousand separation, sentence capitaliza-
tion; n-dash/m-dash, quotation mark and parenthe-
sis checks…  [ -.- | 3.5 ]

- +

English grammar checker: in Tools » Extension man-
ager click on extension, and its Options button.  
[ -.- | 3.5 ]

- +

New gy, gj, gf, etc. Italic ligatures for Hungarian and  
new font features for ligature handling (ligc, lith, litt).
[ -.- | 3.5 ]

- +

Better typography of Catalan.  [ -.- | 3.5 ] - +
Updated pt-BR spellchecker.  [ -.- | 3.6 ] - +
LightProof grammar checker for Brazilian Portugu-
ese pt-BR available. Improvements in spell checking. 
[ -.- | 4.0 ] 

- +

More checking rules pt-BR LightProof grammar 
checker.  [ -.- | 4.1 ] - + ▸

Updated Swedish spell-check dictionary.  [ -.- | 3.6 ] - +
Updated French spell-check dictionary / thesaurus.  
[ -.- | 3.6 ] - +

Updated Czech thesaurus.  [ -.- | 3.6 ] - +
Improved German language tools with over 30,000 
new words added to dictionary, and new symbols to 
the thesaurus. Better hyphenation patterns. [ -.- | 3.6 ]

- +

Improvements Danish spellchecker and thesaurus.  
[ -.- | 3.6 ] - +

Autocorrection improvements for pt-BR.  [ -.- | 4.0 ] - +
Updated Slovenian thesaurus.  [ -.- | 4.0 ] - +
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The legacy kludge for Catalan Valencian UI transla-
tion [ca-XV] got proper [ca-ES-valencia] tag.  [ -.- | 4.2 ] - +

Legacy kludge [sh-*] locales made proper [sr-Latn-*] 
with support of [sh-*] for existing documents.  
[ -.- | 4.2 ]

- +

Added Ladin_Italy [lld-IT] locale data for full locale 
support.  [ -.- | 4.2 ] - +

Improved language tools German (de-AT, de-CH, de-
DE). Over 10,000 words added to spell-check dictio-
nary, updated hyphenation patterns.  [ 4.0 | 4.2 ]

+ +

Lao (lo_LA) spell-check dictionary added.  [ -.- | 4.2 ] - +
Brazilian Portuguese (pt_BR) spell-check dictionary 
updated.  [ -.- | 4.2 ] - +

Spanish spell-check dictionary updated.  [ -.- | 4.2 ] - +
Swedish spell-check dictionary updated.  [ -.- | 4.2 ] - +
French spell-check dictionary updated.  [ 4.0 | 4.2 ] + +
Dutch spell-check dictionary updated.  [ -.- | 4.2 ] - +
Scottish Gaelic (gd_GB) spell-check dictionary upda-
ted.  [ 4.0 | 4.2 ] + +

Slovenian thesaurus updated.  [ -.- | 4.2 ] - +
Latvia adoption of the Euro. 'EUR' currency to [lv-LV] 
and [ltg-LV] locale data and made default currency. 
Added 'LVL' Latvian Lats to the Euro Converters.  
[ -.- | 4.2 ]

- +

Estonian Kroon "EEK" conversion to the Calc 
EUROCONVERT() spreadsheet function.  [ 4.0 | 4.2 ] + +

Catalan Valencian [ca-ES-valencia] locale data.  
[ -.- | 4.4 ] - +

Portuguese spell-check dictionary update.  [ -.- | 4.4 ] - +
New French spell-check dictionary update.  [ -.- | 4.4 ] - +
New Slovenian thesaurus update.  [ -.- | 4.4 ] - +
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8-03 dates and numbers

8 WORLDWIDE NATIVE USE AND TOOLS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

dates and numbers AOO 4.1 LO 4.4

If a day of month (D or DD) is present in a number 
formatter’s date format code, the month will be dis-
played in possessive genitive or partitive case.  
[ -.- | 3.5 ]  

- +
▸

Greek Characters mode for bullets and numbering.  [
-.- | 3.4 ] - +

Autotext "Formula numbering" (fn+F3) has been 
corrected for most locales.  [ 3.4 | 3.5 ]  + +

Implemented locale dependent date acceptance 
patterns for input of incomplete dates.  [ -.- | 3.6 ]  - +

New numbering types.  [ -.- | 3.5 ] - +
Persian words:  [ -.- | 3.5 ]   سه دو، -   ... یک، +

Arabic abjad letter squence:  [ -.- | 3.5 ]  ...   ج ب، ا، - +
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8-04 language tools

8 WORLDWIDE NATIVE USE AND TOOLS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

language tools AOO 4.1 LO 4.4

Template repositories with many languages, see 
templates.services.openoffice.org / templates.libre-
office.org.  [ 4.0 | 4.0 ] 

+ +
▸

Grammar check + Lightproof editor toolbar.  [ -.- | 3.5 ] - +
Run-time compilation and update of grammar 
checking component.  [ -.- | 3.5 ] - +

Improved spellchecker, thesaurus and hyphenation 
patterns.  [ -.- | 3.6 ] - +

When choosing the locale in language options, the 
locale indicated as default is default of the operating
system.  [ -.- | 3.6 ]  

- +

Idxexample.odt localizable via PO files.  [ -.- | 4.0 ] - +
agenda/fax/letter/report templates are localizable.  
[ -.- | 4.0 ]  - +

Support font localized forms (locl) in Writer.  [ -.- | 4.1 ] - +
Improved hyphenation in Calc and Draw.  [ -.- | 4.1 ]  - + ▸

Optional URL to more error-details SingleProofread-
ingError::aProperties. The property needs to be na-
med FullCommentURL. A popup starts.  [ -.- | 3.5 ] 

- +

Shipping Adobe’s Source Sans Pro 2.0, including an  
expanded range of characters. Support of Cyrillic, 
Greek and IPA writing systems.  [ -.- | 4.3 ] 

- +

Support ignoring diacritics Right-to-left languages.  
[ -.- | 4.2 ]  - + ▸

Fix comment toggle button position in case of Right-
to-left locale set to Right-to-left language.  [ -.- | 4.2 ] - +

Non-standard hyphenation, and (soft hyphen based)
dialog window suggesting hyphenation.  [ -.- | 4.3 ] - +

New method to specify character changes before 
the hyphenation break sometimes needed.  [ -.- | 4.3 ] - + ▸

Complete hyphenation of Dutch, Norwegian, Swe-
dish, Catalan, Hungarian without the modification of
the TeX-like hyphenation patterns.  [ -.- | 4.3 ] 

- +

Ability to translate gallery files using a .desktop file 
syntax '.str' file placed next to the gallery.  [ -.- | 4.1 ] - +

Support for BCP 47 language tags. Reading and wri-
ting ODF 1.2 fo:script and *:rfc-language-tag attribu-
tes. Reading / writing tags from/to OOXML.  [ -.- | 4.2 ]  

- +

TeX-like input Unicode subscript/superscript charac-
ters: cm^2  cm², H_2O  H O, H^+  H .  → → ₂ → ⁺ [ 4.1 | 4.4 ] + +

Russian proof-reading rules updated.  [ -.- | 4.4 ] - +
Spanish AutoCorrect patterns and typographical 
rules.  [ -.- | 4.4 ] - +
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8-05 miscellaneous

8 WORLDWIDE NATIVE USE AND TOOLS (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

miscellaneous AOO 4.1 LO 4.4

Reworked the grammar checking dialog to better 
show the error help.  [ -.- | 3.5 ] - +

New typographic features by improved Graphite 
port.  [ -.- | 3.5 ] - +

Release of Libertine Open Fonts, see: NEWS.pdf and 
NEWS.odt, fontfeatures.pdf and fontfeatures.odt.  
[ -.- | 3.5 ] 

- +
▸

Improved windows input method alignment using 
IMR_QUERYCHARPOSITION.  [ -.- | 4.1 ] - +

Catalan Valencian [ca-ES-valencia] is supported as 
language for document content.  [ -.- | 4.2 ]  - +

Character attribution / spell-checking, added to list: 
Ngäbere_Panama [gym-PA], Kumyk [kum-RU], Nogai 
[nog-RU], Karakalpak Latin [kaa-Latn-UZ],  Ladin [lld-
IT], Puinave [pui-CO].  [ -.- | 4.2 ] 

- +
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9. Basement

9-01 API changes

9 API CHANGES, INTERFACE, CODE (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

API changes AOO 4.1 LO 4.4

C++ UNO Language Binding and URE Libraries.  
[ -.- | 4.0 ] - +

C++ UNO again Language Binding and URE Libraries.
[ -.- | 4.1 ] - +

Headers for store and reg libraries were removed 
from the SDK.  [ -.- | 4.1 ] - + ▸

Changes to Unpublished UNO API's.  [ -.- | 4.1 ] - +
macro SAL_PRGEXTENSION removed.  [ -.- | 4.2 ] - +
stricter requirements cppuhelper/shlib.hxx.  [ -.- | 4.2 ] - +
unused cppu::invokeStaticComponentFactory remo-
ved.  [ -.- | 4.2 ] - +

CPLD_ACCESS removed from C++/Java loaders.  
[ -.- | 3.6 ]  - +

osl_getEthernetAddress and osl/util.h removed.  
[ -.- | 4.2 ] - +

the macro EXCEPTIONS_OFF removed.  [ -.- | 4.2 ]  - +
SDK no longer has the autodoc documentation tool. 
[ -.- | 4.2 ] - +

Obsolete --java4 command line parameter removed.
[ -.- | 4.2 ]  - +

Added 64-bit builds for OS X.  [ -.- | 4.2 ] - +
Experimental API allows (initially) LibreOffice's filters 
to be re-used by directly linking to the LibreOffice 
core, via a very tiny static library / shim).  [ -.- | 4.2 ] 

- +

Symbols & source server LibreOffice on Windows. 
Makes it  easy to get a backtrace.  [ -.- | 4.2 ] - + ▸

UNO services are converted to new-style services.  
[ -.- | 4.2 ]  - +
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9-02 removal / deprecation

9 API changes, interface, code (since version 3.4) OFFICE SUITE ILLUSTRATION

removal / deprecation AOO 4.1 LO 4.4

Dropped support for legacy binary StarOffice files.  
[ 4.0 | 4.0 ]  + +

Dropped support for export Word/Excel (6.0/95) 
files.  [ -.- | 4.0 ] - +

Dropped support for ODMA document management
integration.  [ -.- | 4.0 ] - +

Dropped legacy STLport library.  [ -.- | 4.0 ] - +
Deprecated Mac / PPC as a platform, raising our 
base-line to 10.6.  [ -.- | 4.0 ] - +

Dropped support of Windows 2000.  [ 4.0 | 4.0 ] + +
Support Mac OS X for PowerPC has been dropped.  
[ -.- | 4.0 ] - + ▸

Support for Mac OS X’s SDK v10.4 and 10.5 dropped.
[ -.- | 4.0 ] - +

Removing deprecated configuration options.  
[ -.- | 4.0 ] - +

Modules install option removed for Windows.  
[ -.- | 4.0 ] - +

Exporting to OpenOffice.org 1.0 XML removed; users
are recommended to save in ODF.  [ -.- | 4.0 ] - +

"Insert Shapes" panel Sidebar in Draw dropped.  
[ -.- | 4.0 ] - +

Removed: embedding LibreOffice in certain web 
browsers via Wikipedia logo v3.svg.  [ -.- | 4.0 ] - +

Text layout on Linux has been ported to HarfBuzz.  
[ -.- | 4.0 ] - +

Removal UNO API (com.sun.star).  [ 4.0 | 4.0 ]  + +
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9-03 infrastructure

9 API CHANGES, INTERFACE, CODE (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

infrastructure AOO 4.1 LO 4.4

Updated build environment Windows Server 2012R2
with Visual Studio 2012).  [ -.- | 4.3 ] - +

Integration with IDE kdevelop, Microsoft Visual 
Studio, Vim.  [ -.- | 4.3 ] - + ▸

Mac OSX 32 bits build (10.6 and 10.7 deprecated).  
[ -.- | 4.3 ] - +

LibreOffice 4.4 OS X 10.8 or later. The binary 
packages provided are 64-bit only.  [ -.- | 4.4 ] - +

LibreOffice will accept using a Java that is a symlink.  
[ -.- | 3.5 ] - +

Support Java 7. User can select between Java 6 or 7.  
[ -.- | 3.5 ] - + ▸

Java and advanced options combined.  [ -.- | 4.0 ] - +
Use of the new Berkeley DB installed on the system. 
[ -.- | 3.5 ] - +

Check for Updates automatically at user defined 
intervals, allows manual download of new version.  
[ 4.0 | 3.5 ]  

+ ++

User profile path on Linux now ~/.config/libreoffice.  
[ -.- | 3.5 ]  - +

9-04 code quality

9 API CHANGES, INTERFACE, CODE (SINCE VERSION 3.4) OFFICE SUITE ILLUSTRATION

code quality AOO 4.1 LO 4.4

Dead code removal reducing code size & bloat.  
[ -.- | 3.5 ] - +

Improved code quality based on the Coverity scan 
analysis.  [ 4.1 | 4.2 ] + + ▸

SOLAR_USER_RTL_TEXTENCODING environment: 
Support ndocumented variable removed.  [ -.- | 4.2 ] - +

Major refactoring and cleanup of CL code.  [ -.- | 4.3 ] - +
Translation of source code comments into English.  
[ -.- | 4.4 ] - +

Further improved code quality based on the Coverity
scan analysis.  [ -.- | 4.4 ] - ++ ▸
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